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Jagat taran golden Jubilee school

Class -7
Subject :- science
(2020 - 21)
Assighment — 3

Read chapter 3 (Fibre to fabric) properly from NCERT science text book.
Do the following questions in your assignment copy :-
(a) Explain the sequences of processes involved in wool processing.
(b) Explain the process of obtaining silk.
(c) Draw diagram to show life cycle of a silk moth.
(d) Explain —shearing, sorting, sericulture, reeling of silk.
Link for the assignment
https://diksha.gov.in/cbse/play/collection/do 312796455263043584117078?contentType=Text

Book&contentld=do 31279858549559296017187

Link for the vedio tutorial Q
https://diksha.gov.in/cbse/play/collection/do 312796455263043584117078?contentType=Text

Book&contentld=do 31274794791965491214682

https://diksha.gov.in/cbse/play/collection/do 312796455263043584117078?contentType=Text

Book&contentld=do 31274794800815308814684

Teacher — snigdha bhattacharya
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J.T. GOLDEN JUBILEE SCHOOL,
PRAYAGRAJ.

SESSION:

2020-2021

CLASS: VI

SUBJECT: Computer

Science

TEACHER: Neha Jaiswal
ASSIGNMENT llI

STUDY MATERIAL

Lesson: 2 Charts in Excel 2010

Thoroughly go through the chapter given below.



CHARTS
IN EXCEL 2010

IN THE CHAPTER

e Chart Components
e Various Chart Types
e Charting Rules

e Creating a Chart

* Elements of a Chart
e Chart Tools

e  Formatting a Chart
e  Sparklines

£ Think and Ink

Observe and write the lowest number from the given data.

50 Chart Title
70 :z /\
75 © Pl N\

o & N\
80 w0 AN
90 »
40 ‘ 1 2 3 4 5 6

Which of the two options is more convenient to find the lowest number?

Excel is a spreadsheet application in MS Office suite that lets you store, manipulate and analyze
data. It can be used to enter all sorts of data and perform different functions or calculations.
Excel helps to easily incorporate range of data into a neat graphical display. These graphical
displays make the data attractive, easy to read and evaluate.

A chart is a graphical representation of data in a worksheet. It is more attractive and appealing. It
helps you to understand the data easily. It draws comparison between the data. Excel can build a



chart automatically based on the existing data. Later on, chart can be moved, resized and deleted
without affecting the data in the worksheet.

Chart Components

1. Chart Title is placed at the top of each chart. It is used to display information regarding the
visualized chart, i.e. heading for the chart.

2. Chart Area is the place, which represents a layout region of the chart that holds data series,
axis, data, legend, etc.

3. Data Series refers to the sets of values that are going to be on the chart, it may be a line, a
bar, a slice, etc.

4. Plot Area presents the actual chart which includes both axis, data labels, gridlines and data
series.

5. X-Axis or Category Axis is the horizontal axis of the chart.

0. Y-Axis or Value Axis is the vertical axis of the chart.

7. Legend tells you, what each bar, pie, etc. represents on a chart. It is usually colour-
code or pattern given to the data series. It has the names beside them that are from the
spreadsheet.

8. Gridlines are used to make the data in a chart easier to read. You can display horizontal and
vertical gridlines.

Chart Area
Performance Report — ChartTitle
100 ]
Data Series %0
ﬁx‘“—u__&g‘_
70
60
50 T Plot Area
//ﬂ
Gridlines | 34
&
10
0
Engllsh Hindi Mathematics Science S.5t. |
Y axis X a)(ls ‘ W Abir Ghosh W Aryan Gaba ®Bani Narang m Daksh Kalra }— Legend
Fig 2.1: Chart Components
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Various Chart Types

Types of Charts

Description

Column/3-D B
Column Ir-il

It represents the data in the form of vertical bars. It displays
individual values that can be compared to each other and
shows multiple series of data. Itis the most commonly used chart.

Bar/3-D Bar o3 ]
A

It represents the data in the form of horizontal bars. It displays
individual values that can be compared to each other and
shows multiple series of data.

Line/3-D Line H:":(

It represents the multiple series of data in a line format with data
markers; representing each value in that series. Data markers can
be displayed in a variety of formats including triangles, squares,
diamonds, etc.

Area Chart ¥

-

It is similar to the line chart, except that the areas under the lines
are filled in.

Pie/3-D Pie
series

#

It displays only one data series as a group. Each value in that
1s displayed as a slice of that pie. The size of the slice is displayed

as a percentage that the value contributes to the whole series.

Scatter Chart

It is known as X-Y chart also. It is used to compare pairs of value.

Doughnut Chart -.-)

It is similar to a pie but displays more than one series. It displays
series as rings and each ring is divided into slices like a pie chart.

Waterfall Chart Il
|

It provides a great method to visualize the impact of multiple data
points typically a series of positive and negative values.

Rules to Create Charts

There are three basic rules to create charts:

1.

Excel does not automatically add a chart title and a sub title to your chart based on the first
row and the second row of selected information. You can add the chart title and sub title

during the chart layout.

Do not leave any rows and columns empty in your source data otherwise chart will leave
empty space for every empty row or column.

If there are more rows than columns, Excel will plot the data by column. The first column
becomes the X-axis labels, the remaining of the columns are the data series. The first row
after the title becomes the legend’s labels and if columns are more than rows than Excel will
follow same rule but vice-versa.

Creating a Chart

It is very easy to create a chart in Excel but before that you must enter data into a worksheet.

To create a chart in Excel follow the steps given:

Charts in Excel 2010 5/



Step 1: Select the data for which you want to create a chart.

4 R i e e G
i

2 | Roll No. Name English Hindi |Mathematics| Science 5.5t
3 1 Abir Ghosh 80 80 92 87 85
4 2 Aryan Gaba 67 78 89 9 50
5 3 Bani Narang 50 85 86 79 78
6 4 Daksh Kalra 87 67 69 65 75
7 5 Gurleen Kaur| 68 70 75 79 76
8 6 Harman Vij 54 67 71 84 87
9 7 Sanvi Garg 82 &9 86 79 85

Fig 2.2: Sample Data

Step 2: Click on the Column drop-down menu in Charts group of the Insert tab.

Step 3: Click on Clustered Column, the first column chart in the 2-D Column list.

a My Line - il Area = o]
@B Pie v | Scatter~ L
Col

u::mn }Barv l.'_)[i}‘l:herchar‘r:sv | Jmi

| 2-D Column E

(ldm) [=8) B8]
ol o898 9
o] [82] 9
I Jad] ) |4

Cone
Fig 2.3: Selecting Clustered Column Chart

Excel places the chart as an embedded object on the current worksheet and the Design, Layout
and Format tabs appear on the Ribbon.

EH9-™~-|= Marksheet - Microsoft Excel
Home  Inset  Pagelayout  Formulas  Data  Review  View | Design | Layout  Format

e @E =
i
Change Save As Switch Select | | |- LR

Chart Type Template | Row/Column Data

B b [k ek |

Chart Layouts | Chart Styles

Type Data
\ Chart 3 - 5|
4 e e e | B s [ G M |
il
2 | Roll No. Name English | Hindi |Mathematics| Science | S.5t.
3 1 Abir Ghosh 20 80 92 87 a5
4 2 Aryan Gaba 67 78 89 91 90
5 3 Bani Narang 90 85 86 b3 (3
6 4 Daksh Kalra 87 || 100
7 5 Gurleen Kaur 63 ag
8 6 Harman Vij 54 80
9 7 Sanvi Garg 82 70 4
10 50 W English
| L] 50 4 B Hindi
12 N 4
== B Mathematics |3
13 40 .
==l | Sei
i 30 cience
15 20 w55t
16 10
17 0 -
18 Abir  Aryan  Bani Daksh Gurleen Harman Sanvi
19 Ghosh Gaba Narang Kalra kaur  Vij Gag
S0

Fig 2.4: Clustered Column Chart

Smart Bit

To create a chart instantly, select the data that you want to represent in the chart and then press
the F11 key.

% Charts in Excel 2010



To switch rows and columns

Sometimes, you may want to change the way charts group your data. To switch the rows and
columns, follow the steps given below:

Step 1: Select the chart you want to modify.
Step 2: From the Design tab, select the Switch Row/Column command in the Data group.

Step 3: The rows and columns will be switched. In our example, the data is now grouped by
names, with columns for each subject marks.

Insert Page Layout Fo T 100

==l 90
=
e 20
Switch Select 70 B Abir Ghosh
|Row/Column| Data
Data 60 B Aryan Gaba
30 7 M Bani Narang
Fig 2.5: Selecting Switch Row/Column option .| 40
g g / p : B Daksh Kalra

30 A
20
10 -~
o A

B Gurleen Kaur

B Harman Vij

B SanviGarg

Fig 2.6: Switched rows and columns

Elements of a Chart

You can add the different components of chart like Chart Title, Axis Title, Legend, etc. whenever
you require.

Adding Chart Title

To change the chart title, follow the given steps:

Step 1: Click on the chart to which you want to add title. It will highlight Design, Layout and

Format tab.
Formulas Data Review

]ﬂ@ @nu

Step 2: Click on Chart Title in the Labels group of the
Layout tab.

. . . rt | Axis Legend Data Data
A list of OpthIlS will appeatr. v |Titles = - Labelz * Table =

Step 3: Click on Centered Overlay Title or Above Chart
under the Chart Title option. A box with the words Chart
Title appears on the chart.

Mone
Do not display a chart Title

—

Centered Overlay Title |
Owerlay centered Title on
chart without resizing chart
Above Chart

Display Title at top of chart
area and resize chart

More Title Options...

| [=]

——
=
=

Step 4: You can type the desired title by double-clicking the
new text box that says ‘Chart Title’.

Hl@-

AR
ST H]

Fig 2.7: Selecting Chart Title option

Charts in Excel 2010



Adding Legend

A legend helps readers to understand the graphical components of a chart. For example, in a
bar chart, the legend tells the readers what each bar of a particular color or pattern represents.
Legends can be placed anywhere within the chart area, but are commonly located at the bottom
of the chart. To change the position of alegend of chart, follow these steps:

Step 1: Click the chart to which you want to edit and change the position of legend.
Step 2: Click on Legend in the Labels group of the Layout tab.
A drop-down menu will appear.

Step 3: Choose the desire option (e.g. Show Legend at Right, Show Legend at Top, etc.).

Adding Axis Title
To add title to the axis, follow the steps:

Step 1: Click on Axis Titles option in the Labels group of the Layout tab.
Step 2: Select Primary Horizontal Axis Title option to add title for an X axis.

Step 3: Click on Title Below Axis. The Axis Title box appears at the bottom. Type the title in
the box.

Similarly, by selecting the Primary Vertical Axis Title option you can add Y-axis title.

Adding Data Labels
Step 1: Click on Data Labels option in the Labels group of the Layout tab.

Step 2: A drop-down menu will appear. Choose the desired option from the list.

The data labels will be inserted at the desired points.

Chart Tools

There are many ways to customize and organize your charts. For example, Excel allows you to
change the chart type, its layout, style, location and so on.

To change the chart type:

If you find that your data is not well suited to a certain chart, it is easy to switch to a new chart
type. To change the chart type, follow the steps given below:

Step 1: From the Design tab, click the Change Chart Type command.

.i. Hame
Change | 5Sawve As

Chart Type | Template

Fig 2.8: Selecting Change Chart Type option
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Step 2: The Change Chart Type dialog box will appear. Select a new chart type and layout, then

click OK. In our example, we will choose a Line chart.

[Cd Temoates ‘Lolumn — ‘
S ] ) 8 98
& = T
= ) ol B8] ) ] Jab) A8
Area _ —
e |48 Whin (8] |AD] b
@ Surtacz e
@ Doughut ﬁ /;f:,’; I/,L* @ ::::; & @
22 Bubbl —
dy Padar e —
Ml e o] Akl an] e
((tenge temaates. ] [[sesasuetautibere ]

Fig 2.9: Selecting a chart
The selected chart type will appear.

! 700 cln.a.rt_-l:ltl.e.-

600 W
soo . J —+— SanviGarg

400 H—— —8—Harman Vij
e e P e e —#—Gurleen Kaur

B A———*""'—-—-‘-_-_-‘___A —— Daksh Kalra
fl 200
1 —i— Bani Narang

100
+ + h —8— Aryan Gaba

300

]

' —#—AbirGhosh

Fig 2.10: Changed Chart Style
To change the chart style:

Excel provides several preformatted chart styles that can be used to change the appearance of
the chart. A chart style includes pre-formatted colors, background, shading, gradients, etc. which
gives your chart a consistent visual appeal. To change the chart style, follow these steps:

Step 1: Select your chart.

view View Dlesign &

Step 2: Under the Design tab, in the Chart Styles é ’@ E@H@rigi

group, click on the More arrow. It will display all the l‘ -
available chart styles for a particular chart type.

Fig 2.11: Selecting a design

Step 3: Choose the chart style. The chart will appeatr 1% 1% 17 77 T« T« [ W
with new style. :

500 —t—Sanvi Garg

p—— : i —8—Harman Vij

S =#=Gurleen Kaur

E e —<—DakshKalra |}
| 200

.——-—'."' = Bani Narang
e et i == Aryan Gaba
' —#—Abir Ghash

Fig 2.12: Changed Chart Style
Charts in Excel 2010 2



Formatting a Chart

You can change the format of individual chart elements, such as the chart area, plot area, data
series, axes, titles, data labels, or legend.

To format a chart:

You can format any element of the chart by selecting it. For example, to format the plot area of
chart, follow the steps given below:

Step 1: Select the Plot Area.
Step 2: Right-click it and click Format Plot Area.

a4

~ A" A7 |Plot Area -
EA-B-2-F
I

[ 7000 CrartFite—— " 7

600 -‘——__'-_‘—___4’___‘_——_—{» Delete
500 ._._____—.——s'_ Reset to Match Style

400 ——qu;'—"_x__ H - ﬁ Change Chart Type...
=] I
200  — _--*:——-—w%————-x E) seledt Data...
: —— * 4 J | 3-DRotation...
200 +——mm—————— e
1 % Format Plot Area...
100 = + @ *
v v h —8— Aryan Gaba
00 T & ' —e— Abir Ghosh
& & .&':’ @S"’Q o
N &y
A
&
<+

Fig 2.13: Selecting Format Plot Area option
The Format pane appears on the right side with options.
Step 3: Click on the Fill tab and select Pattern Fill radio button. Choose the desired pattern.

= sl -

Al BED
Border Color ® Nofil
Border Styles © sold fil

@ Gradient il

Shadow

@ Picture or texture fill —+—Sanvi Garg

Glow and Soft Edges | | @ pattern fil

3D Format @ Automatic —&— Harman Vij

—#—Gurleen Kaur

88 EYE

B =
' EE
T f

»— Daksh Kalra

—d— BaniNarang

—— Aryan Gaba

—— AbirGhosh

Foreground Colar:
Bagkground Color:

Fig 2.14: Selecting Pattern Fill Fig 2.15: Applied Pattern Fill in Plot Area

Similarly, you can format any chart element by selecting the chart element (for example, data
series, axes, of titles), right-clicking it and clicking Format <chart element>.

Sparklines

A sparkline is a very small line chart; typically drawn without axes or coordinates. Sparklines are
introduced in Excel 2010 to be a convenient alternative to charts. These are miniature charts that

220 Charts in Excel 2010



fit into a single cell. It presents the general shape of the variation in some measurement, in a
simple and highly condensed way.

These charts are usually located very close to the data they represent, making it easier both to spot
trends in the existing data and to see how changes would affect the results.

Types of sparklines
There are three types of sparklines:

1. Line: Similar to a line chart, the Line type of sparkline can appear with or without a marker
for each data point. The first group is the example of line sparklines.

2. Column: Similar to a column chart, the second group shows the Column sparklines.
3. Win/Loss: A Win/Loss sparkline H .
is a binary-type chart that displays o_ . LI : - =T

H Hull "un

each data point as a high block or a

low block. In this sparkline, each data =
B.EE_ " "

- . m_ B - = - =

point is depicted as a high block (win)
represented by blue square or a low
. _EEN

block (loss) represented by red square.
- _u
Il _B. “="u==

Line Column Win/Loss

Fig 2.16: Sparklines

Sparklines are ideal for situations where you
want to make the data clearer and more eye
catching and where you do not need all of
the features of a full chart. On the other
hand, charts are ideal for situations where
you want to represent the data in greater detail and they are often better for comparing different
data series.

SN

To create sparklines

Generally, you will have one sparkline for each row, but you can create as many as you want in any
location you want. Just like with formulas, it is usually easier to create a single sparkline and then
use the fill handle to automatically create sparklines for the remaining rows.

The steps to create a sparkline are as follows:
Step 1: Click on the Insert tab.

Step 2: In the Sparklines group, select the Line option. The Create Sparklines dialog box will
appear.

E Line |

E Column

]E Win/Loss
Sparklines

Fig 2.17: Selecting Line option

Charts in Excel 2010 F28)



Step 3: Specify the Data Range and Location Range where you want the sparkline to be. Click

on OK.
r ™ K
Create Sparklines @ A B | C | o} | E | F | G | H |
Choose the data that you want 1 eh 3 ;
2 MName Englis| Hindi [Mathematics| Science 5.5t
DataRange: |C3:G3 3 [ AbirGhosh | 80 80 92 87 8 [_~—
4 | Aryan Gaba 67 78 39 91 30 e
Choose where you want the sparklines to be placed 5 |Bani Narang 90 35 36 79 78 —
Location Range: |5HSBSHSB:SHSQ 6 | Daksh Kalra 87 67 63 65 75 —
7 |Gurleen Kaun 63 70 75 79 76 R oo
& | Harman Vij 34 67 71 84 87 —
[ ok ][ conel ] 9 | SanviGarg | 82 89 86 79 85 |~
10

Fig 2.18: Specifying Data Range

Fig 2.19: Sparklines

The sparklines will appear in the document.

Sparkline Formatting Options

After inserting the sparklines, you will find a new ribbon called as “Sparklines Tools — Design”
ribbon. This is where all the formatting options for sparklines are included.

E D= Marksheet - Microsoft Excel Sparkline Tools o = R
Home Insert Page Layout Formulas Data Review View Design 4] 0 o B

M E E E High Point First Point .| [ sparkline Color ~ E IH] Group

1]
Low Point Last Point \/\/\ \/\/\ \/\/\ \/\/\ ~| I Marker Color ~ = If"1 Ungroup

Edit Line |Column Win/Loss — Axis

Data~ MNegative Points Markers = - &2 Clear ~
Sparkline Type Show Style Group

Fig 2.20: Sparkline Tools — Design Ribbon

Some of the key formatting/customizations you can do are,

1. Change the sparkline type.

2. Change the source data/target cells of sparkline.

3. Setdifferent colors for first point, last point, highest and lowest points (applicable for column
and line chart types).

4.  Setaxis options (show/hide axis, set min and max value for vertical axis, set axis type to date
axis, etc.).

5. Group/ungroup a bunch of sparklines.

6. Remove or clear sparklines.

Sparklines and Missing Data - How does it work?
1.

A A

24

If the sparkline source data contains non-numeric data, they are neglected while plotting the

sparklines.

If data has some #NA values, they are neglected.
If data has blanks, sparkline shows blanks too.

If data has zeros, zero value is plotted.

If data has some hidden rows/columns, the values are neglected (unless you enable “Show
data in hidden cells” option).

Charts in Excel 2010



RECAP

e Charts are graphical representation of data in a worksheet.
e It helps you to analyse and draw comparison between the data.

e Chart Area is the place, which represents a layout region of the chart that holds
data series, axis, data, legend, etc.

e Data Series refers to the sets of values that are going to be on the chart, it may be
a line, a bar, a slice, etc.

e Plot Area presents the actual chart which include both axis, data labels, gridlines
and data series.

e A sparkline is a very small line chart.

EXERCISE
A. Tick (v) the correct answer.

1. The tab provides various chart style options.
a) Layout b) Design ¢) Format

2. It displays only one data series as a group.
a) Pie Chart b) Bar Chart c) Line Chart

3. presents the actual chart which includes both the axis, data
labels, gridlines and data series.
a) Plot Area b) Chart Area c) Legends

4. They are miniature chart that fit into a single cell.

a) Sparkbars b) Spark columns c) Sparklines
5. Which chart type displays data in form of a circle?

a) Line b) Pie c) Bar

B. Fill in the blanks.

1. is referred to the sets of values.

2. In chart, each data value represents one slice of a pie.

3. is the vertical axis that is used to plot the values.

4. is usually used to identify the colour-code or pattern given to

data seties.

5. A is a very small line chart.

Charts in Excel 2010 F%5;



C. Write True (T) or False (F).

Bar chart represents the data in the form of vertical bars.
X- axis is the horizontal axis.

Sparkline is a small pie chart.

~> »oN g

The Chart Area contains the actual chart itself and includes data

series, category and value axis as well.

5. Column Chart type displays data in the form of circle.

D. Read the given clues and name the chart types.

1. Itlooks like a small round cake with a hole in the centre.

It looks like a pizza with pieces cut.

2.
3. Itlooks like a horizontal chocolate bar but each bar has different size.
4,

It represents a layout region of the chart.

E. Short answer type questions.
1. What is a chart?

2. How is a Column chart different from a Bar chart?

3. What are sparklines?

F. Long answer type questions.

1. Name and describe any three components of a chart.

2. Write the steps to change the chart style.

2600 Charts in Excel 2010



3. How can you create sparklines?

G. Application based questions.

1. Sanya has created a chart. She wants to improve the appearance of her chart by
changing the chart style. Which option will you suggest her to perform this task?

2. During a cricket match, only five batsmen of the winning team played. Which chart
will help you to demonstrate the individual contribution of each batsman?

H. Lab activity.

1. The following is the information about temperatures in 4 cities on a given day.
Enter the details in Excel and plot a line graph for the given information.

TIME TEMPERATURE
New Delhi | Mumbai | Bengaluru | Jaipur
12 midnight 20 25 32 38
3:00 am 18 24 28 32
6:00 am 16 20 22 28
9:00 am 25 30 33 36
12 noon 32 38 42 46

2. Create a 3-D column chart comparing marks for a student in different subjects.

Subject | UnitI | Term I | Unit IT | Term IT | Total
English 40 85 42 90 257
Hindi 32 70 38 76 216
S.St. 38 79 39 80 236
Science 42 87 45 92 266
Maths 48 96 47 97 288

e Create a Column chart depicting the student’s average marks in all the subjects for
both terms and units.

e Create a Pie chart displaying the overall performance in each subject to the whole.
* Create Line Sparkline chart for each subject.

Charts in Excel 2010 2
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EXERCISE

A. Tick (V) the correct answer.

1.

number system uses 10 as base.
a) Octal \Ja‘)/Decimdl c) Hexadecimal

2. In binary addition 1 + 1 =
a) 2 b) 1 0

3. To convert decimal number into binary number, divide the number by
a) 8 b) 10 A2

4. Which of the following is an octal number representation?

a14), b) (129),, c) (1010),

5. In the number 72096, the most significant digit is
a) 9 b) 6 A7

B. Fill in the blanks.

1. Decimal number system is the most widely used number system.

2. In binary number system, O means OFF state.

3. In hexadecimal number system, letters A to F are used to represent number
from 10 to 15.

4. The rightmost digit of a number has the lowest weight.

5. The leftmost digit of a number is known as most significant digit.

C. Convert the following decimal numbers into their binary equivalents.
i) (120),, = (1111000), i) (354),, = (101100010),
ii) (75),, = (1001011), iv) (24),, = (11000),

D. Convert the following binary numbers into their decimal equivalents.

) (101), = (5),, ii) (110101), = (53),,
iii) (110111), = (55) iv) (00111010), = (58),,
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Perform as directed.

Perform binary addition for the following:

(a) 1000 (b) 1001101
+ 0111 + 1000101101
01111 01001111010
Perform binary subtraction for the following:
(@) 110111 (b) 10011
—-101110 -01010
001001 01001
Multiply the following binary numbers:
(a) 101 (b) 101010
X 011 X 1011
101 101010
101X 1101010%
000%x X 000000%x
01111 111001110

Short answer type questions.

Define number system.

An organised way of representing numbers is called number system.
Define the term base.

Base is defined as the number of digits in the number system.

What is base of a hexadecimal system?

The base of a hexadecimal system is 16.

Long answer type questions.

Write the steps to convert decimal number to binary number.

Step 1: Divide the given number by 2.

Step 2: Write the remainder either O or 1 and divide the quotient again by 2.
Step 3: Repeat the step 2 till the quotient is zero.

Remainders which are obtained at each step are written in reverse order, the obtained
number is the binary conversion of the given decimal number.

Describe hexadecimal number system.

Hexadecimal number system has base 16 as it uses sixteen distinct symbols, digits 0-9 to
represent values from zero to nine and A, B, C, D, E, F to represent values from ten to fifteen.

Application based questions.
Reema wants to convert 5698 into binary system. Suggest her method to do so.
She should divide the number by 2 and write the reminders in reverse order.

The teacher has ?iven an assignment to Ritika on binary subtraction. She is confused how
to subtract (001T), from (1100),. Help her solve this.

(1100),
-(0011),
(1001),
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CHARTS
IN EXCEL 2010

EXERCISE

A.
1.

o

Awd—O

Tick (V') the correct answer.

The tab provides various chart style options.

a) Layout \}))’Design c) Format
It displays only one data series as a group.
a) Pie Chart b) Bar Chart \/r)/l_ine Chart

gridlines and data series.

a) Plot Area \,b’)/Chart Area c) Legends
They are miniature chart that fit into a single cell.

a) Sparkbars b) Spark columns \/:')/Spqulines
Which chart type displays data in form of a circle?

a) Line \/bf)/Pie c) Bar

Fill in the blanks.

Data Series is referred to the sets of values.

In Pie chart, each data value represents one slice of a pie.
Y axis is the vertical axis that is used to plot the values.

Legend is usually used to identify the colour-code or pattern given to data series.

. A sparkline is a very small line chart.

Write True (T) or False (F).

Bar chart represents the data in the form of vertical bars.

X- axis is the horizontal axis.

Sparkline is a small pie chart.

The Chart Area contains the actual chart itself and includes data
series, category and value axis as well.

Column Chart type displays data in the form of circle.

Read the given clues and name the following.
It looks like a small round cake with a hole in the centre.

It looks like a pizza with pieces cut.

It looks like a horizontal chocolate bar but each bar has different size.

It represents a layout region of the chart.

presents the actual chart which includes both axis, data labels,

Doughnut Chart

Pie Chart
Bar Chart
Chart Area
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Short answer type questions.

What is a chart?

Charts is a graphical representation of data in your worksheet.
How is a Column chart different from a Bar chart?

Column chart represents the data in the form of vertical bars that display individual
values that can be compared to each other and can show multiple series of data.

Bar chart represents the data in the form of horizontal bars that display individual
values that can be compared to each other.

What are sparklines?

Sparklines are very small line charts, typically drawn without axes or coordinates. These
are miniature charts that fit into a single cell.

Long answer type questions.
Name and describe any three components of a chart.

Chart Title is placed at the top of each chart. It is used to display information regarding
the visualized chart i.e. heading for the chart.

Chart Area is the place, which represents a layout region of the chart that holds data
series, axis, data, legend, etc.

Data Series refers to the sets of values that are going to be on the chart, it may be a
line, a bar, a slice, etc.

Write the steps to change the chart style.
Step 1: Select your chart.

Step 2: Under the Design tab, in the Chart Styles group, click on the More arrow. It will
display all the available chart styles for a particular chart type.

Step 3: Choose the chart style. The chart will appear with new style.

How can you create sparklines?

Step 1: Click the Insert tab.

Step 2: In the Sparklines group, select Line option. The Create Sparklines dialog box will appear.
Step 3: Specify the Data Range: and Location Range: where you want the sparkline to be.
Click OK.

The sparkline will appear in the document.

Application based questions.

Sanya has created a chart. She wants to improve the appearance of her chart by
changing the chart style. Which option will you suggest her to perform this task?

Sanya should select Design tab and then choose different style from Chart Styles group.

During a cricket match, only five batsmen of the winning team played. Which chart will
help you to demonstrate the individual contribution of each batsmen?

In this case Pie Chart is the best suited.

Note:Write only questions and answers of both the chapters in

8- note book.
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§ Bed

py entering
ar):d driving them out

oes the writer build
our interest in the
:tI:Jl’];'? (paras 1 to 6)

owd

gistrustfully: with

suspicion; in @ way that
showed he could not trust
them

cast a glance: took a quick
look

hangings: curtains or other
objects hung on walls for
decoration

) An Uncomfo rtable

Guy de Maupassant was a Franch writar bast knewa for

his short storiaa. Ha wrote around 300 shont stones, b
with & faw novels and travel books, The Neckiace' snd

‘An Uncomfortabla Bed' are aoma of his moat famaous atories

———— e

. One autumn, I went to spend a few days with some friends

in Picardy.

2 My friends were fond of practical jokes. I do not care to know

people who are not.

3 When I arrived, they gave me a grand reception, which at once

made me rather suspicious. They cheered loudly, embraced me
and made much of me, as if they expected to have great fun

at my expense.

T said to myself: ‘Look out, old ferret! They have something in

store for you.’

During the dinner the mirth was excessive. I thought: ‘Here

are people who are really amused—too amused. There does

not seem to be any reason for so much mirth. Th-ey. must hav‘e
planned some good joke. Surely I am to be the victim of the joke.
Attention!

" The entire evening everyone laughed in an exaggerated fashion.

Just as a dog can smell whatever it is hunting, I could almost smell
a practical joke in the air. But what was it? T was watchful, restless.
I did not miss a single word, or a meaning, or a gesture. Everyone
seemed to be a suspect, and I even looked distrustfully at the faces
of the other guests.

" The hour struck for going to bed. The whole household came

to accompany me to my room. Why?

* They called to me, “Goodnight.”

" I entered my room, shut the door, and remained standing, without

moving a single step, holding the candle in my hand. I heard
people laughing and whispering in the corridor. Without doubt
they were spying on me. I cast a glance round the walls, the
furniture, the ceiling, the hangings and the floor. I saw nothing to
justify suspicion. I heard persons moving about outside my door.

I'had no doubt they were looking through the keyhole.
]

SRR | |
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head: ‘My candle

ame into my
d leave me in

10. An idea C
go out an

may suddenly

darkness.
oom and lighted

11.§p ] went around the T
o1l the candles that I could find. After that
I cast another glance around me without
I moved with

discovering anything:
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ey

.

ghort steps, carefully examining the room. Nathing, | inapected

: bcdslt‘f‘d:‘he frame ole every ardicle, one after the other. Still nothing. [ went aver to the
bed window. ‘The shutters, large wooden shutters, were open, | ahat
gropl::g[:n;;;o:;f:guchlng {hem with great care, and then drew the curtains, enormous velvet
:J:;fhl‘ngs around him as curtains, and placed a chalr in front of them, s0 a3 to have nothing
he could n°! see Inthe (o fear from outside.
dark '

12 Then 1 sat down cautiously. The armchair was solid. 1 did not dare ;_
to get into the be’d.’HBWE\?éE the night was advancing; and 1 finally
came to the conclusion that 1 was being foolish. I was certain that
my friends were spying on me, waiting for the success of whatever
joke they had prepared. Butin that case, they must have been
laughing their heads off at my terror. 1 could not let them have so
much fun at my expense. 1 made up my mind to go to bed.

13 But the bed was particularly suspic@g-}goking. ] pulled at the
curtains. They seemed to be <ecure. All the same, there was danger.
There must be. Perhaps I was going to receive 2 cold shower from
overhead. Or perhaps, the moment I stretched myself out, 1 would

find myself sinking to the floor with my mattress. 1 searched in my

O memory for all the practical jokes I had ever experienced. And 1 did
\/, not want to be caught. Ah! Certainly not! Certainly not!

Wwhat does the writer do 4. Then I

o bild up the SUspense en I suddenly thought of a precaution which could ensure my
further? safety. I caught hold of the side of the mattress carefully, and very

slowly drew it toward me. It came awmd by the sheet and

thfe rest of the bedclothes. I dragged all these objects into the very

glnclgle of the room, facing the door. There, at some distance from

mee W(;t:;lsteadi1 that? could not trust and the corner which had filled

e ;1;;, alnme.ty, I'made my bed all over again, as well as

L cou .1 _ en | extinguished all the candles, and, groping my way {
y newly-made bed on the floor, I slipped under the bedclothes.

i el

it
A

i1 B VIR
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starting: méklng a sudden,
quick movement because
he was surprised

sideboard: a cupboard,
usually kept beside a
dining table, for storing
cups, dishes and so on

smothered: unable to
breathe because his
face was covered by an
unknown weight

Whiskers: the hair growing
Oon a man's face

improvised: made up on
the spot without plan or
preparation

dismayed: shocked and
upset

valet: a person employed
to look after a man's

personal items and tasks

O

T

5. For at least another hour I remal

fo
16. 1 must have been in 2 deep sleep heavy body tumbling down righ

8. Oh, heavens! It was br

ned awake, starting at the Sﬁghh“:-
in the housé. I fell asleep.

3 v quiet
sound. Everything seemec - a long time. All of a sudge, |

I was awakened with @ sta:td‘:;’eal received on mYy fau:e,hmy ;‘eck

) t the sam€ L s me utter 2 how .
et v me ming liquid which rﬂ&decl s st weth ol tzi :
and my chest a zf L a sideboar Plates
pain. And a dlr__#_ea d-g’wf almost deafened me.
flen , rushing me and preventy

dishes had fa
me was C ;
mothered beneath it. 1 stretched

f this object. 1 felt a face
at was the nature O ce,
. with all my strength, 1 struck a l:ﬂ;w at this ]
a nose, and e .ved a shower of slaps which made me
sheets. The door of the room wag
jump straight ou ighishirt.
Jopen. I rushed into | )
oad daylight- The noise brought my
oked into the room with

8!
to the spot. As 110 d bed, a dismayed valet,

friends hurrying my impT Gvise

%’ Ibfc')u;i?l,glyni::egn?; morning cup of tea, he had tripped over
ile brin

th unexpected bed in the middle of the floor and fallen on his
e

stomach, spilling my breakfast over my face. |
i ine the shutters and going
= many precautions by closing an
112:;1 :::k tle::: midc}{hI: of the room. But those very precautlo.ns ha
brought about the practical joke 1 had been trying to avoid.

In paras 16-18, the writer
takes the excitement to 2
peak and then provides
an explanation. What 1
the peak? How does the
explanation add to the
humour of the story?

20. Oh, how they all laughed that day!

Understanding the Text

Answer these questions.

1. My friends were fond of practical jokes. | do not care 0 know people who are not.
a.  From the second sentence, what do you think the speaker valued in his friends?
b.  Can you find any evidence in the text that supports the first sentence?

2. ...which at once made me rather suspicious.

a.  Which other words in the text tell you how the speaker was feeling and acting? (paras
b.  Add one more word of your own to describe his state of mind.

k
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3. ‘Look out, old ferretl They have something in store for you.’
a.  Another meaning of ‘ferret' is to find '
something by searching carefully. Why do you think
the speaker called himself a ferret? ’ R
b.  What did he think his friends had in store for him?

4. Once inside his room, how did the speaker move and act? Why?

3 :Vhy did the Spgaker close the shutters and draw the curtains? (para 11) What happened
s a result of this? What else did he do in para 14 that helped to bring about the outcome?

6. The armchair was solid. (para 12) Why was this discovery important to the speaker?
a. It meant that he could protect himself with the chair if necessary.

D. It meant that he could sleep in the chair.
C. It meant that his friends had not laid a trap for him in the chair.

7. | did not dare to get into the bed. (para 12) Why didn't the speaker dare to get into the bed?

Why did he finally go to bed?

8. The speaker was awakened by a body falling ove
hear at the same time? When and how did he rea

r him (para 16). What else did he feel and
lise what had really happened? (para 18)

Appreciating the Text
n a situation or event which is the very opposite of what was expected,
e the irony in this story?

ry. How does this style

Irony is a term used to mea
and which is sometimes funny as a result. What could b

This story is a first-person narrative—the speaker is a character in the sto
of narration help to build the irony?.

Grammar and Usage » nouns and quantifiers (advanced)

Read these sentences.

» I went to spend a few days with some friends.
» There were eight candles in the bedroom.

.

S —————

In the first sentence, ‘a few’ quantifies the countable noun ‘days’. In the second sentence, the number
‘eight’ quantifies the countable noun ‘candles’.

Here are some more ways to understand how to quantify nouns.
1. We know that some nouns are countable but become uncountable when we use them in a general sense.

i » I will buy a dozen bananas. / The banana is a fropicai fruif. ke

2. There are other nouns, especially abstract and material nouns, which are typically uncountable. We use
the structure a... of ... to quantify these nouns.

[ _ _,
» a kilo of coal; a tonne of steel; a period of calm; a degree of suspicion.

3. There is yet another category consisting of nouns which are usually uncountable but can become
countable depending on usage.
| » Thereisa fear that elcphant_s are still poached for ivory. / Getting an educ_atién is critical in the présent day

SLdAdllliccyu vill wd



A v
« Underline th
8 uncount 1
w able wi 3 i '
hich rule applies to each 2;) :::,9 in these sentences and fte 1y 2 or 3 depanding on |

. There ;
. Expe .‘S a grain of truth in what he says. rule 2
SXperience is a good teacher. UN — !/

. Their fami
mily has been in business for many years.
an exiinguisher.

excltemsnt-

1

2

3

4. tisd > without

) Itis difficult to put out fire without

. Th are
.e coming months are a period of eXTZ—
6 s
o0s these 98

-

8

- Seaweed is a widely used component in shamp

ery special and rare-

. It was a friendship that was v
. He received a shower of praise for s now 00K
» revision: prow

some of them very pasic 1o our language-

| kinds of pronouns.
he, she. it; they

her, it, them

hers, its

We have leamed severa
subject pronouns - |, we, you
object pronouns - me, us, you: him,
possessive pronouns — Mine: ours, yours, i
demonstrative pronouns — this, that, these: R

relative pronouns - who, whom, which, that, whosé,

reflexive (and emphasising pronouns) selves

themselves
We have also leamed that there is another I
bove, the indefinite pron

definite pronouns &
In the singular, We use: one, each, other, either,
nobody, No one, nothing,

gveryone, gverything,
For more than one; we use: both, few, others, M

For both singular and plural, we use: all, some, an

theirs
atever, whichever

himself, herself, itself

whoeVv
urselves,

— myself, our . yourseh‘, yO
lled indefinite pronouns. Unlike

t refer to any specific person or thing.
anybody, anyone, anything, everyb

one, somethingd

arge group of pronouns cal

neither, another,
somebody, some

any, several
y, more, most, none

B. Complete these sentences with suitable indefinite pronouns from the boxX.
several anyone noone another sorhething .. faﬁr m(IJst céch
Something tells me that It will rain this afternoon. | can almost smell the rain

2 Has @D seen my glasses?

| don't thibk this fits, could | try /27U E:"Ei’,-"(;please’?

1 V . . f

L
a £V E A f
e fr k

5 1 ’
don't have many music CDs, but Neetu has /£

6. NO_ QN0
can surpass his greatness as a music composer

7. Both these
cakes look deliciou :
8. Just a few people h s. | will be greedy and have one of .. oLhy
: ave accepted the invitation but S 3. :
F7st have refused.



Words in Use

A. Match each of th
: ese words to
prefixed words, a prefix, Then,

prefix word -

~ hona_sdl __m_“_._
E; expectegi_ -
ds " polte
_11_1:#_#_ comfdrtable B
trustful
\ practical

1. The guest felt uncomfortable when his friends started quarrelling.

It would be rather, Iptea ttg’ wear sandals on a trek!

After his friends played a prank on him, he felt Aubus 90 "/‘Jr‘o them.

Mother taught us that it |3¢U’)’£b@{b&é to criticise a gift.
The ﬁmG_yb_@(‘/&% ding of the story both surprised and amused her.
g e, _

@ A~ w0 N

)

() - !‘.‘ N ¥ ; ]:.'_‘. A

~.
Cu

B. Use these phrases from the text to rewrite the sentences. .

atmy / his / her expense:
cast a glancef L Al

- made much of
in store for
- made up my mind

1. 1 went to watch a film which did not receive good reviews.
The film did not receive good reviews. All the same, | went to watch it.

Her cousins were Iaughing at her. Alia did not seem to mind.

He took a quick look at his notes. Then he entered the
examination hall.

Rohan's classmates gave him a lot of attention when he won

» profiven

complete these sentences with the corract

The students are debating the question, ‘Is it always fdg‘ﬂ._..{g[ 28] i’tE) hide the truth?’

» phrases in context

the quiz competition.

After a lot of thought, | decided to go to Himachal, and not
Kerala.

| think my family has planned a surprise for my birthday.
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An Uncomfortable Bed

Guy de Maupanzant

This story I3 told in the first person. The spesker I8 visiting some friends. From the moment
he arrives at their house, he is convinced that his friends—who like practical jokes—zre
about to play a prank on him. Everything makes him suspicious —from how warmly they
welcome him to how cheerful they look at dinner. He even wonders why 50 marvy people
come to accompany him to his bedroom 2t bedtime,

When the speaker enters his room, he steps carefully, lights all the candles, and examines
everything. He finds nothing suspidous. He closes the window shutters, draws the heavy
curtains and places a chair in front of them <o that he cannot be reached from outside

. through the window.

At first, he sits in the armchair because he does not dare to get Into the bed—the prank,
whatever it is, must have been set up at or around the bed. Yet, as the night advances, he
argues with f\imself that his friends, who he thinks are waiting outside his door for the
success of the joke, must be laughing at him for being so scared. He cannot let them have <o
much fun at his expense, <o he decides 1o go to bed after all.

The bed-curtains seem secure, but what if he receives a cold shower from overhead or sinks
down to the floor as <oon a5 he lies down? Finally, the speaker thinks of a clever precaution.

He pulls the mattress and the bedclothes down to the floor and makes his bed there, in the
middle of the room, lacing the door. Then he puts out the candles and RO Lo slesp.

He is woken up rather abruptly, when a number of strange things happen at once. A heavy
body falls on top of him; a burning liquid falls on his face, neck and chest; there is a noice of
plates and dishes crashing. He tries to understand what has fallen on him and feels a face.

He ctrikes at it, in return receiving a series of <laps himeell. He then jumps out of the bed
and rushes outside,

There, the speaker finds that it is marning. The noise brings his friends to the spot as well.

All of them look into the room and realise what really happened. It is the valet wha is lying
on the bed on the floor, shocked. When he entered the room with the speaker’s tea, he
could not see the bed on the floor, since the candles were extinguished and the cunains
were drawn, and Wmbled down on top of the speaker,
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b Assiﬁ;nm.'entrtld be done

I' iy a] Allﬂ the work to be done in English Literature Register Copy.
b L] '_’Dc:il' Iyo_LI:Ir work neatly.
| 1) Ilié’i;:k.:.:dlu:f:Zd diffiﬁu[t words from the chapter and write them three times in your literature

.' cdpiesl. i||| ||
i) Wr'it'zle: t}\é ujv'orrl.! meanings given in the chapter neatly.

| (I
3) 'Make sentences with the following words- hangings, smothered, groping, whiskers, dismayed,

I\ralét. |

I i 4) ‘Do the following exercises in your copies (answers given be'low]-
| i ANSWER THESE QUESTIONS

RRIES GRAMMAR AND USAGE- A and B

! | jil.  WORDS IN USE-Aand B

:! I | f -
Mt |

i ,’l iR . —
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-cmss:v LITERATURE— CHAF-TE# |1 AN UNCDMFORTABLE BE  F e Fenime =
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~ ANSWERS OF UNDERSTAlNllDINGl |T}|1I|E TEXT(PAGE NDJI AND Sfsis e =
FEER PR e

ANSWER THESE O.UESTiONS | | I| I Il I F
i s ] | Il (1) || '|
1.a.The second senterluze tells us that the speaker valued asense of humourm hls tnends £

: e A -
b. The cmh,,ir ewdence thet we 'can fmd m the text for the first sentence is the way the

| speaker’ 5 frlends Iaughed when they found out what had happened We do not see them
actuaily playmg any pract:ca! JDkE on the speaker

2t a. watchful restless, dlstrustfuily, carefully, cautmusly

b. Sample answers newous}'apprehenswe e .

3. a. The speaker calls hlmself a ferret because he was trylng to find out whatkmd of
_prank his friends could play on hlm He was trying to ferret out the truth, and hewasalso
: actmg a bit hke a ferret— huntmg for clues and trying to ‘catch’ his friends

- b The speaker thought t[hat his frlends had set some kmd of trap for h[m or set hlm o
fora practtcai jeke L el | . ' : —_—

- 174 Once ms:de his room the speaker shut the door, and remained standmg, without maov-
., ing a single step. He Iuoked around at the walls, the fumlture, the ceiling, the hanﬂmgs
 and the floor He timught that his candle may go out, so he lighted all the candles in the
'room. He moved with short steps, carefully examinlng the room, and inspected every ar-
‘ticle, one after the other, He was convinced that his friends had laid a trap for him inside

e roem, so he was being careful and trying to check everythmg

; The speaker closed the shutters and drew the curtalns 50 that 1 na trlck could be played
| on hu‘n thmugh the window, As a result of th:s, na light cnuld come mto the room from"
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outside. In para 14, he made his bed in the middle of the room, on the floor, and extin-

guished all the candles. Since the room was now cnmpletely dark, when the valet came
in, he could not see the bed on the floor and tnpped over it.

b.c

7. At first, the speaker did not dare to get into .’.che bed because he was sure that his =
friends had made some arrangement in the bed for a prank. Yet, he also thought that his -
friends, who must be waiting for the success of their trick, would be laughing at him be-

cause he was too afraid to go to bed. He could not let them have so much fun at his
expense and went to bed to challenge them.

8. As the speaker was awakened by a body falling over him, he felt a burning hot liquid
on his face, neck and chest. It made him howl with pain. At the same time, he heard a
great noise, as if many plates and dishes had fallen down. It was then that he realised it
was morning, and in the light from the corrider, he saw that the valet, while bringing his

tea, had tripped over his bed and fallen down, along with the plates he had been carrying
The hot liquid had been the tea.
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4.1 A MIND-READING GaME!

The teacher has said that she would be starting a new chapter in
mathematics and it is going to be simple equations. Appu, Sarita =
and Ameena have revised what they learnt in al gebra chapter in
Class V1. Have you? Appu, Sarita and Ameena are excited because

they have constructed a game which they call mind reader and they
want to present it to the whole class.

The teacher appreciate.f) their enthusiasm and invites them to present their game. Ameena
begins; she asks Sara to think of a number, multiply it by 4 and add 5 to the product. Then,

she asks Sarato tell the result. She says itis 65. Ameena instantly declares that the number
Sara had thought of is 15. Sara nods. The whole class including Sara is surprised.

Itis Appu’s turn now. He asks Balu to think of a number, multiply it by 10 and subtract
20 from the product. He then asks Balu what his result is? Balu says it is 50. Appu
immediately tells the number thought by Balu. Itis 7, Balu confirms it. '

Everybody wants to know how the ‘mind reader’ presented by A_ppﬁ, Sarita and

Ameena works. Can you see how it works? After studying this chapter and chapter 12,
you will very well know how the game works.

4.2 SEeETTING UP OF AN, IguaTION ‘
Letus take Ameena’s example. Ameena asks Sara to think of a number. Ameena does not
know the number. For her, it could be anything 1,2,3,...,11,...,100,....Letus
denote.this unknown number by a letter, say x. You may use y or t or some other letter in
place of x. It does not matter which letter we use to denote the unknown number Sara has
thought of. When Sara multiplies the number by 4, she gets 4x. She then adds 5 to the
product, which gives 4x + 5. The value of (4x + 5) depends on the value of x. Thus
ifx=1,4x+5=4x1+5=9. This means that if Sarahad 1 in her mind, her result would
have been 9. Similarly, if she thought of 5, then forx =5,4x+5=4 x5+ 5=25; Thus
if Sara had chosen 5, the result would have been 25.

e e ——

e S S A
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packward from her answer 65. We

ht by Sara letus work

To find the number thoug
have 1o find x such that (4.1)

v +5=05 | |
‘ hich Sara held in her mind.
ber Balu chose as y- Appy

product. Thatis, fromy,

ywill give us the number W
Letus call the num
btract 20 from the
It is known to be 50.

Solution to the equatior
Letus similarly look at Appu’s example.
asks Balu to multiply the number by 10 and su
Balu first gets 10y and from there (10y = 20). The resu
10y - 20=50
on will give us the number Balu had th

(4.2
Therefore,
The solution of this equati

ought of.

- , 1T+~ K oyl
REVIEW OF WHAT WE KNOW
Let us recall what we learnt about equations in

) 2) are equations. ) ; ;
Note, (4.1) and (4.2) are eq able. In equation (4.1), the variable is x.

Class VI. An equation is a condition on a vart
in equation (4.2), the variable is y.

The word variable means something that can : )
different numerical values; its value is not fixed. Variables are denoted usually by

letters of the alphabets, such as X, % % I m, n, p, etc. From variables, we Ji ary
expressions. The expressions are formed by performing operations like addition, SUbIraCtlDﬂ.
multiplication and division on the variables. From x, we formed the expression (4x+5).
For this, first we multiplied x by 4 and then added 5 to the product. Similarly, from y, we
formed the expression (10y —20). For this, we multiplied y by 10 and then subtracted 2(
from the product. All these are examples of expressions.

The value of an expression thus formed depends upon the chosen value of the variable
As we have already seen, whenx =1, 4x +5=9; whenx = 5, 4x + 5 =25. Similarly,
x=15, 4x+5=4x15+5=65;
x=0, 4x+5=4x0+5=>5;and soon.

vary, i.e. change. A variable takes on

when

" when
Equation (4.1) is a condition on the variable x. It states that the value of the expression
(4x+5) is 65. The condition is satisfied when x = 15. It is the solution to the equation
4x +5=65. When x =5, 4x + 5 = 25 and not 65. Thus x = 5 is not a solution to the
equation. Similarly, x = 0 is not a solution to the equation. No value of x other than I3

satisfies the condition 4x + 5 = 65. -

. .The vaIUf: of the expression (10y — 20) depenﬂs on tHe valu.e of y. Verify this by
giving five different values to y and finding for each y the value of (10 y —20). From
the different values of (10y - 20) you obtain, do you see a solution to 10y —20=50’

If there is no solution, try giving more values to y and find whether the condition
10y — 20 = 50 is met.
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4.4 Wuar Eguano

nan equation there is always an equality sign. The equality sign shows that the value of
the expression 1o the left of the sign (the left hand side or LHS) is equal to
the value of the expression to the right of the sign (the right hand side or RHS). In

equation (4.1), the LHS is (4x + 5) and the RHS is 65. In equation (4.2), the LHS is
(10y - 20) and the RHS is 50,

—

If there is sm.ne sign other than the equality sign between the LHS and the RHS, it is
notan equation. Thus, 4x+5 > 65 is not an equation.

It says that, the value of (4x + 5) is greater than 65.

Similarly, 4x+5 <65 is not an equation. It says that the value of (4x + 5) is smaller
L_lh;m 05.

In equations, we often find that the RHS is just a number. In Equation (4.1), it is 65

and in equation (4.2),itis 50. But this need not be always so. The RHS of an equation may
be an expression containing the variable. For example, the equation

4x+5=6x-25
has the expression (4x + 5) on the left and (6x—25) on the right of the equality sign.

In short, an equation is a condition on a variable. The condition is that two

expressions should have equal value. Note that at least one of the two expressions
must contain the variable.

We also note a simple and useful property of equations. The equation 4x+5 = 65 is
the same as 65 = 4x + 5. Similarly, the equation 6x — 25 = 4x +5 is the same as
4x + 5= 6x —25. An equation remains the same, when the expressions on the left
and on the right are interchanged. This property is often useful in solving equations.
ExAMPLE 1 Write the following statements in the form of equations:

(i) The sum of three times x and 11 is 32.
() If yousubtract 5 from 6 times a number, you get 7.
() One fourth of mis 3 more than 7. |
(iv) One third of a number plus 5 is 8.
SoLuTION
(1) Three times x is 3x.
Sum of 3x and 11 is 3x+ 11. The sum is 32.
The equation is 3x+ 11 =32,
() Letus say the numberis z; z multiplied by 6 is 6z.
Subtracting 5 from 6z, one gets 62— 5. The result is 7.
The equationis6z-5=7
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() One fourth of m is 7

i

m
: ifference (—-7)is 3.
Itis greater than 7 by 3. This means the diff y

The equation is e 7=3.
4 o .
(iv) Take the number to be . One third of 115 7" [

n !
This one-third plus 5 is — +5. Itis 8.

3 ==
n
The equation is Tt 5=8. m

; g e t form:
Exampie 2 Convert the following equations in statement forim
- . - N m
) x-5=9 (i) Sp=20 @ 3n+7=l @ 3 2y

Sowution () Takingaway 5 from.x gives 9.
“ﬂ (i) Five times a number p is 20.
i{«‘ "uﬁ; (i) Add 7 to three times n to get I. I
A3/ l (iv) You get 6, when you subtract 2 from (?ne- of a number 5,
g/ / ( Jj What is important to note s that for a given equation, not just one, but many Slate
/Y forms canbe given. For example, for Equation (i) above, you can say:
Iy Subtract 5 from x, you get 9.
L. S o o .| or Thenumber xis 5 more than 9.
Wiite atleast one other formfor oy The number x is greater by 5 than 9.
each equation (ii), (iii) and (iv). = The difference between xand 5 is 9, and so on.

o

Exampre 3 Consider the following situation:

Raju’s father’s age is 5 years more than three times Raju’s age. Raju’s father js 44 ver |
old. Set up an equation to find Raju’s age. ' e P "'

Sovution  Wedo not know Raju’s age. Let us take it to be y years. Three times |

Raju’s age is 3y years, Raju’s father’s age i . that |
i, Reju's father sy ) s g€ 18 5 years more than 3y; that |

ok e Id. It is also given that Raju’s father v
There{or?; 3}’ +5=44 I
This is an equation in . It will give Raju’s age when solved e

ExampLE 4 A shopkeeper sclls mangoes in tw
large. Alarge box contains as ma, 3;) JPEs of boxes
Set up anequation which gives the

The number of mangoes in a large b,

i » One small and one
eyt XeS plus 4 Joose mangoes.
i givanm:i;gb:es In each small boy,
SoLuTtioN Let a small qu contain m mangoes, A]arge b 100
times m, that is, 8m +4 mangoes, But this g 0X containg 4 more than §

8m +4 =100 8iven to be 1), Thus

You can get the number of mangoes in a sma]] box by solving ghis _ 4.4)
- lon,

T
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ExeRrcisg 4,1

1, Complete the last column of the table.

E?o Equati Value -1 Say, whether the Equation
i is Satisfied. (Yes/ No)
M | x+3=0 x=3
—fii) r+3=0 x=0
-_ZIE] r+3=0 xX=-3
W | x-7=1 x=17
(\9) e ] x=8
(W) Ayl Cx=0
(i) | Sx =25 'S
vii) | Sx =25 xX=-5
m
(ix) 7 2 m=-6
m
® [ 7=2 m=0
m
W) | 3 =2 m=6

2. Check whether the value given in the brackets is a solution to the given equation.

or not:

(@ n+5=19(n=1)

®) Tn+5=19(n=-2) () Tn+5=19(n=2)

d 4p-3=13(p=1) () 4p-3=13(p=—4) () 4p-3=13(p=0)
3. Solve the following equations by trial and error method:

M sp+2=17

@) 3m-14=4

4. Write equations for the following statements:

(i) The sumofnumbersxand4is9.

(i) Tentimes ais 70.

(v) Three-fourthofzis 15.
(vii) One-fourth of a number x minus 4 gives 4.
(vi) If you take away 6 from 6 times y, you get 60.

(x) Ifyouadd 3 to one-third of z, you get 30.

5. Write the following equations in statement forms:

) p+4=15 (@ m-7=3

v) 5

m=6

(vi) 3p+4=25

(i) 2 subtracted fromyis8§.
(iv) The number b divided by 5 gives 6.
(vi) Seventimes m plus 7 gets you 77.

" m
i) 2m=7 (iv) ?:3
vi) 4p-2=18  (vii) §+_2=3
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)¢ ation in the following cascs: |
R e - re than five times the marbles Parmi
(i) lrfan says that e has 7 marbles MO a

it’ i
Irfan has 37 marbles. (Take to be the number of Parlr]m; ;:;?::f:m .’ . ,I
i) Laxmi's father is 49 years old. Heis4 years older than thr g |
(Take Laxmi’s ag¢ {o be y years.) |
(i) The teacher tells the class that the highest rpar
class is twice the lowest marks plus 7. The highe

scorctobe ) o
(v) Inanisosceles triangle, the vertex angle 1s twice either base angle. (Let the by,

angle be b in degrecs. Remember that the sum of angles of a triangle is 18

ks obtained by a student ip he
st score is 87. (Take the lowe,

degrees).
4.4.1 H0IVINgE oan ‘_"\.-.'i'g!"_"!.f:‘.f‘.'-‘._?’i'!. |
Consider an cquality g-3=4+1 (45

The equality (4.5) holds, since poth its sides are equal (eachis equal to 5).
® Letusnow add 2 to bothsides; asa result
LHS=8-3+2=5+2=7 RHS'=4+1+2=5+2=-‘7.
Again the equality holds (i.¢., its LHS and RHS are equal).
Thus if we add the same number to both sides of an equality, it still holds.
® [ ctusnow subtract 2 from both the sides; asa result,
[HS=8 ~3-2=5-2=3 RHS=4+1-2=5-2=3.
Again, the equality holds. |
Thus if we subtract the same number from both sides of an equality, it still holds.

Similarly, if we multiply or divide both sides of the equality by the same non-zero
number, it still holds. )

For example, letus multiply both the sides of the equality by 3, we get
LHS=3x(8-3)=3x5=15RHS=3x(4+ 1)=3 x 5=15.
The equality holds.

Letus now divide both sides of the equality by 2.

LHS=(8-3)+2=5+2= %
RHS=(4+1)+2=5+2= % =LHS
Again, the equality holds.

If we take any other equality, we shall find the same conclusions.

Suppose, we do _not observe these rules. Specificially, suppose we add different
numbers, to the two sides of an equality. We shall find in this case that the equality does no!

el
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 jtsboth sides are not equal). For example, let
e B-dmduy o iekeagsin equality (4.5)
HS and 3 to the RHS. The new Ljg is8.-13

C
e : +2 =
+3=51 3=38. The equality does not hold, bec e s ot

qual ause the new LHS and RHS
L e fail 10 do the same
v, Y
ﬂ""': -, does 10! hold.
(i hat iablesis
h oquality that involves variables is an equation,

mathematic
cal operati
operation on both sides of an equality,

ions are also valid f :
o c nclusi or equations i
T:s; )  umber only. s a8 in each equation variable
(o™ . s said to be like a weighi
oftena? cq}lalltl]ge adding Weight:‘? weighing t-)a]ance. Doing a mathematical operation
| o oquation s 1 0 orremoving weights from the pans of a weighing

| IR
o™ tionis likea weighing balance with equal weights on ‘
boll; (s pans: i which case the arm of the balance is exactly
hoﬁzonml' [fwe adq th.e Same weights to both the pans, the arm
. porizontal. Slmllarl}!, if we remove the same weights from
ahepans thf: arm remains horizontal. On the other hand if we : 0\
i gifferent welg}}ts ?0 the pans: or remove different weights from | LHS. R.H.S.
em, the balance is tilted; that s, the arm of the balance doesnot {4 balanced equation is ' ! i.ke a
m@nhoﬁmﬂtﬂl- weighing balance with equal weights
in the two pans.

weuse this principle for solving an equation. Here, ofcourse,
(he balance i imaginary and numbers can be used as weights that can be physically

halanced against each other. This is the real purpose in presenting the principle. Letus

yake some examples.
¢ Consider the equation:  x+3= 8

We shall subtract 3 from both sides of this equation.

Thenew LHS is x+3-3=x and thenew RHSis 8-3=5
Why should we subtract 3,
A

and not some other
number? Try adding 3.
Will it help? Why not?

It is because subtracting 3

(4.6)

x+3
e : \ reduces the LHS to x.
Since this does not disturb the balance, we have
New LHS = New RHS or X=3
the equation (4.6).

“‘r = . -
hich is exactly what we want, the solution of
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To confirm whether we are right, we shall put.x=35 in the 0“_8"(11211 equatioy, W,
LHS = v 4 3 =5 + 3 = 8, which is equal to the RHS as required. )

ration (i.¢., subtracting 3) on both the Sideg :

1

By doing the right mathematical ope

equation, we arrived at the solution of the equation.

; 1=10
@ Letus look at another equation x-3=1 §

; (4
: sides, By doin
What should we do here? We should :_1d(] 3 to. both lh{c sides, By doing so, y,, .
retain the balance and also the LHS will reduce to just.x.

New LHS =x-3 +3=x, NewRHS = l()+3=l3
° Therefore, x = 13, which is the required solution.
By putting x = 13 in the original equation (4.7) we confir, ol
the solution is correct: .
3 10 LHS of original equation=x-3=13-3=10
— This is equal to the RHS as required.
— @ Similarly, let us look at the equations |
;,’__ e 5y=35 (4&
A b 7= a
Ya! (R Y/ O | | | ' |
{ ' l.‘ A=A Inthe first case, we shall divide both the sides by 5. This will give us just y on LH; |
TR )y _ X 35 5x7
NewLHS=Z=>2=y NewRHS= ST
Therefore, - y=1
This is the required solution. We can substitute y="7 in Eq. (4.8) and check that ;|
satisfied. _.
In the second case, we shall multiply both sides by 2. This will give us just m on t
LHS :

The new LHS = %’-xZ =m. The new RHS =5 x 2 = 10.

Hence, m=10 (1t is the required solution. You cancheck whether the solution s correct] |
One can see that in the above examples, the operation we need to performdepend; {
on the equation. Our attempt should be to get the variable in the equation separated |

Sometimes, for doing so we may have to carry out more than one mathematical operation |
Let us solve some more equations with this in mind.

LAMPLE 5 Solve: (a) 3n+7=25 (4.10) j}
(b) 2p-1=23 \ @10k

SOLUTION -
(a) We go stepwise to separate the variable n on the LHS of the equation. The LHS s {

2 3n+7. We shall first subtract 7 fromit so that we get 3n. From this, in the next step

we shall divide by 3 to get #. Remember we must do the same operation on both
sides of the equation. Therefore, subtracting 7 from both sides, |

In+7-7=25-7 | (Step)) ‘.
- 3n=18
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NowW divide bothsides by 3,

n g
31Ty
3 (Step 2)
" — =06, which is Lhe Solution
Jhould we do here? First ywe shal '
Wwhat shou Shalladd 1 o idas:
| o TI0 0 o oth the sides:
} 2 =2 (Step 1)
= 2 : 2p 24
divide both sides by 2, we Bf —m Y
Now & 2 2 (Step 2)
o | P= 12, which s the sojutiop
One good practice you should develop s to check tf

Alhoug . . Jetusdo it for this example
etusput the solution p = 12 back into the equation,
LHS=2P-1=2><12-1=24_1 ,
=23 =RHS I

The solution is thus checked for its correctpess.
Whydo you not check the solution of (a) also?

We are now in a position to go back to the mind.
Sarita, and Ameena and understand how they got the
look at the equations (4.1) and (4.2) which corresp.
Appu’s examples.

¢ First consider the equation 4x + 5 =635,

reading game presented by Appu,
ir answers, For this purpose, let us
ond respectively to Ameena’s and

Subtracting 5 from both sides, 4x+5-5=65_5. (4"1)
ie. 4x =60 .
Divide both sides by 4; this will separate x. We get %Ez %9 |
or x = 15, which is the solution. (Check; ifit is correct.)
® Now consider,10y — 20 = 50 4.2)

Adding 20 to both sides, we get 10y — 20 + 20 =50 + 20 or 10y=70

- 10 70
Dmdmgbolhsidesby 10, we get 2 _ =

10 ~ 10
y =7, which is the solution. (Check if it is correct.)

You will realise that exactly these were the answers given by Appu, Sarita and Ameena.

ﬂ?ey hadlearnt to set up equations and solve thém. That is why they could construct their

" reader game and impress the whole tlass. We shall come back to this in Section 4.7,

or .
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_ ExrroisE 4.2
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—

1. Give first the step you will use to separate the variable and then solve the equati
\@F-1=0 () x+1=0  E1=5 (@ x+6=2
A S@T-4=-T7 O y-4=4 @Tr4=4 @T+i=d
:%:f 2. Give first the step you wil}b use to separate the variable and then solve the equaticr‘%

= 31 =42 ®) ;=6 =i @ =2 |

5 1
\ﬁ?@;% dﬁ/§=g' @ §=% Mm—l()%

3. Give the steps you will use to separate the variable and then solve the equation:

20 3

@)3n-2=46 () Sm+7=17 (c) Tf’:zxo d 1_102=6

4. Solve the following equations:
- o L )2
(a) 10p = 100 (b) 10p + 10 =100 (c) 1 5 (d) _3__5
3p a
=" () 3s=-9 (g) 3s+12=0 (h) 35=0
@) 2g=06 () 2¢-6=0 (k) 2q+6=0 @) 2g+6=12
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(T -030R2)
HET-0
fawa-siepa
&P - WP d-HRdl - 3
(R YT ufeer v faxdiegest )
UTS T -3 S1ag HIRdH
(ASSIGNMENT NO. 3)
PT-UF TEAT - 3

forg faenefa,

e PTY-UF T -3 ( Assignment no.-3) T Fafiid U2 & IR T&bd STRYRIHT H fora)-

9. JHTYU UG HETHRA HETHIA! & BRI & ATH foral |

.M Tsg $U TG I ol |

3. TH 'Y BT AC ADR, TS ABR, Ag dPR, dlc ddR Td fAfiferg dHR Huaw) o foral .

¥,  URAIY B PIs Urd ARV pd H forgl|

4 YRd BT IFH Td AP M T 52 37 QI b R DM 62 (I T AP T b1 WA SbR)
o)

REFERENCE YOU TUBE VIDEO LINK: https://youtu.be/AuXFrild xI



https://youtu.be/AuXFr11d_xI

P LIRCTROP N Oy ta _;} é.r\" N \ 3“34- B I DA R D K R S
AN, 3TEHIH 9T ARl oy

IR ghaue: | fRaew 5

L CRaI L PR E= i

fe<TeMErR: R a@ﬁ

g | :
Ioqan: = fafeer: wafsr| g 99 e wguee sl

qIG aguEE: oun At o & favewfasr: 99, gUunty, THEM,
TEMREY, Mgdeed: T A ST A W S-S ASTSIed:
TRIE: | IRFT-TEH S ST SRET: TR-gHNed: TEAaeH: =)
ATE-STTERTERTY -G SR, - SR SEhE: A
AT Ta| SSHIM, AT AR fafaey &3y o uf| 9Rd 3 ® g
IS AN G ST s e ey

egHE S ARG SeRiareH | T WFH: = ‘ArRgw il
ST Qe T A 9 TE ° ST | WA TS e
M| ARG STHaTan], Tehel 1fE| Yo, ARaey &y g



SR WA

o e ey ,,._..._ - ___,vv"'{‘l?
bz PIeE-HUE (Word List) =724

g (F) =[G 21 (be victorious)
YFauion: = Had I AT
(the gem of the crown)
e (33 + wfE) = S 2 (is like)
weE (9-@1e) = 961 & (washes)
qAUEEG: (FYET + e :) = FHar e
(Narmada, etc.)
waefe (9-=7) = 324l & (flow)
[EmEt: = 9gd ol (very long)
ogAT: = dgd Ag (ample)
ayfEy (T9+ whgy) = 99—l &
(prosperity)
TEEAt (F-32) = 952 T4 ©
(reveal)
Horgur: = 397 (dresses)
fa=m: fa=n: = 3TAT7-37a7 (different)
raTET: = Helq (houses)
Iar: = 3cd4g (festivals)
FIgETE = IEAR % 91
(with brotherhood)

-

e UZ =T THE (Read and understand)

Faar: (39) - 79 7T (composed)
wferzraTza: (FE2TH + AT =
Fifeerd ae (Kalidasa, ete )
g e =1 (like)
g (40 + FF:) = ElLgETite
(brave women)
g = &9 & A
(national leaders)
T (9 + @) =
g (reformers)
wEg (9 + ) = g%l (only here)
srireraT: = 3790 (leaders)
seaTeafaETAT = STEATCATaE §
(in spiritual knowledge)
fif (R = 9E, T
(profound)
TerhE (A=Y + W) = FA @
(truth alone)
sEviETEy = 3ME¥ a9 (motto)
sFrEaTaT, = 3Fdl # (in diversity)

( o —31 Sl F 5 F 3eE T 309 fa9R F1 969 e §1 g9r—

FifeAard + 3Eg: = FIfAEET:
ofg & 99 92 §—

(i) T TRy, (i) =9E 9 3R (i) fet gt
T & T H B S-AEdd # = A wed 1w At F Uiy 92 9 §) 39

Y UF §— EF qEr

& oy o gum =X fHOoe &9 o STd 8 g9r—
/30 + IA/AT= 31T

T4+ AL =TI
W+ =gafEm o

o + e = fedred:
T + G = TE




AR T —, TN AT A A AT

0 IR TR F =T F ST P - - TR
RS CTRE i "HTERT, wﬁaﬁm|$j@ Sl M1 e
L st e —  ¥91, FEETR
2. T TgHHAF — =, goy
3. ER Hiferg 0 e, AR
4. THU Yfag — W, W, gy
S. TR Hiferg —  ggfg, kg
6. IR HMTE — 7@, oy
ISTH TP &Y ST g w1t 36 9 T T o §, S R w a3 vl % '
mﬁmmaaﬁ%i ’
S H 3o Ifors ‘g, w3k gy’ [
o R B o T o T

2 T L
A e T

o

; "#i“ ]
e

I. ¥%pd W 392 &1 (Answer in Sanskrit.) -
(F) RO IOUCIMA &: AET?  wrgaza Saaiseme adagrs: feare: s |
(@) 3TET I &F: ?
(TN RO ST 12
(&) ARG 3TeRiasy &2

wfr-faese &4 (Disjoin the sandhis.)

I, THeRY:, 9, g, 9

3. g gﬁg'gﬁ’m%mﬁﬁmﬁﬂwmﬁﬁﬁﬁ%ﬁl

(Decline [write the forms of] the $-ending masculine word ‘g’ in the 3rd and 6th
case-endings.)

4. uTETFER Sfae A & faw e @ gfa sl
(Fill in the blanks with suitable names according to the lesson.)

(F) vREeT & qEAEH 0 ameeftt e gdm -----

-------------------

| B



....................
........

() 9T smestarry

..........

() TRTH Ty

s.ﬁwﬁmm%m,ﬁm@mmﬁl ‘ g
(Identify the gender, case-ending and number of each of the following word forms,)

fery ferafaq -
(F) gtr: e o . TaaEa
(@) GERRIERY oo s
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6. Frefafes vkt & ard R (Write the meanings of the following words.)
g, qEaST:, G FAAE, FeTerEfd

7. ¥¥Fa ¥ srgare w4 (Translate into Sanskrit.)

(%) W B9RT <97 ) (India is our country.)

(@) = T 7 &y (Kalidasa was a great poet.)

(T) IR S TS &&=l 21 (Delhi is the capital of India.) |
(%) R 3t <feqor faem & @R #1 (The Indian Ocean s to the south of India,)
(3) Il TET & F24t |1 (The river Ganges flows here.)

() R & &= F el #1 (Indians are leaders in various fields.)
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REFERENCE YOU TUBE VIDEO LINK:

https://youtu.be/AuXFrlild xI
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STUDY MATERIAL
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LESSoN 1: DEMOCRACY

Thoroughly go through the chapter given below.



sation is known as government.
There are three main types or forms

of government which exist in the
world today. These important systems of
Dictatorship. power are Democracy, Monarchy and
DEMOCRACY

The word ‘democracy’ has been derived

fiom the Greek Word ‘demokratia’ which means These el
“demos’, ‘the people’ + ‘kratia-"power o rule’, | ese elected persons form the government by

' e : .+ ¢ this system, the government is directly responsible
Thus, democracy is a form of government in which :

S » . to the people. It has to explain its actions and
people have a voice in the exercise of power, . defend its decisions to the people. Most countries
_in the world today have a democratic form of
" In simple words, democracy means a rule by |
the common people. It is a form of government
in which peogle Iglect their own representatives. | MONARCHY
People are supreme. No body or institution is .

been derived from the Greek

typically through elected representatives. |

above them. The government is answerable to the

People and only the people can change it through
“nstitutional provisions., It is the people ».vho
&Ve the government the power to make dec:s!ons
nd enforce laws. They do this through elections

| i e Cab‘inel Ministers

Indian Prime Minister wi

© a government by a sovereign
" head of state, especially a
king, queen Or emperor. -
- 'In a monarchy, the head
\\of Ig:e royal famil))(f is the head of the nation| Thee
. monarch or the king or queen is succeeded by h'ls
or her closest relative (mostly the eldest son) in
. hereditary succession. In this system, the monar.c:
. takes decisions and runs the. govemmer;:,i:nt.
the help of a small group of ministers Or adviSors.
| The kings or the queens
: their actions, neither

. in which electors vote for a government from a
i range of political parties. In fact, people vote for

particular persons or candidates and elect them.

government. For exanple, India, U.S.A. etc.

The word ‘monarchy’ has

word ‘monarkhia’ which _
means ‘the rule of one’. Tt is

Queen-Elizabeth-1I
4%

don’t have to explain
do they have to defend their

—
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decisions in front of anybody. Morocco, Saudi '

Arabia and Jordan have a monarchial form of
i transferred from the king to the two

government.

DICTATORSHIP

fn a dictatorship, people have no rights and all
the powers rest in the hands of one man. That is,

there is a single ruler with absolute powers. Most
dictators gain power either through a military :

takeover or by seizing leadership from an existing
ruler. [In this system, citizens cannot raise any
question about the government and its method of
functioning. A citizen is not the master of his fate
and is always at the mercy of the dictator. General

the power has been gained by force.

ORIGIN OF DEMOCRACY

The origin of demaocracy can be traced back to
ancient Greece. The word ‘“democracy’ is of Greek
origin. It is as old as the ancient Greek civilisation.
The earliest democratic system emerged in the
Greek city of Athens where all the adult male
population formed an assembly and participated
in the decision-making process directly.

In the Roman Republic also, there were some
elements of representative democracy. Some public
posts were filled by elections.

Jzmmmeemm Remarkably, one of
the earliest instances
of democracy were
found in ancient India.
Sometime before
the 6th century BC,
the Mahajanapad of
Vaishali (presently in
Bihar, India) was the
vﬁﬂd_’s,ﬁrsuepubhr_ The democratic Sangha,
Gana and Panchayat systems were present in
some of these republics. The Panchayat System is
still in practice in Indian villages.

Modern democracy is quite different from the
democracy that prevailed in the ancient period.

Britain is regarded as the first modern democracy. : economic and

T

After the civil war in the 17th century,

the T
absolutism came to an end and the el

POwer V;'as

S houses of
Parliament. These houses were the House o

Lords and the House of Commons which had

elected chamber. Earlier the right to vote wag bas::jl
on the ownership of property. It was only wit, the
implementation of Equal, Franchise Act, 1928 that
women secured the right to vote. The Universy)
Adult Suffrage was achieved much later. Frap,
became a republic after the French Revolutiop,
1787. The United States of America remaineg
a partial democratic country from 1787 to 1943

. because the right to vote was limited to very fey;
Parvez Musharaff of Pakistan and Saddam Hussain !
of Iraq were examples of dictators. A dictator is a

ruler who has complete power over a country and ; ¢, pe fought to make the world safe for democray,

people.
The First World War (1914-19) was announced

The end of the war witnessed a great popularity for’
democracy. Similarly, after the Second World War
(1939-45), democracy as a form of government,
became the norm in most countries. Moreover,
new waves of democracy spread over Europe in
the 1970s and late 1980s when representative
governments were set up in the nations of
Southern, Central and Eastern Europe respectively.

WHY DEMOCRACY AND
THE KEY ELEMENTS OF DEMOCRACY

The following are the significant elements
that continue to make democracy popular in the

i contemporary world.

Formal Equality -\

{ Equality and justice are the central theme of
democracy.]Both these terms are inseparable
Equality is the precondition that ensures justic®
for all the people of a society or country.
democracy, everybody is given an equal status- Mo
discrimination BT : s
is done on the
basis of caste,
religion, colour,
race, etc) Every
individual has
equal .political,

Equality in society

SOCIAL SCIENCE-:: %
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il rights. Whether it is the Preside

Nt of the :
country or a common man, all are subject o i not value one another. They arise when a group
laws. In a democracy all ad € ! of people feel th ; : 7
came 18 ’ adult People are : € that they are superior while some

“ en right to vote. The value of each v,

- other groups feel that the
 hether it is of the rich or the poor.

otejs e i
qual, . against. Thus, differences

lead to violence and loss

Y are being discriminated
often create conflicts that
. ) of lives and property.
ision-making Mecha i i
pecision-m ; 9 : nisms | But.thcse1 differences can be settled by
people participate in the deCiSion-makin . deve]oplngatolerantattit'ude. Democracy provides
rocess in a democracy. But they do not'; - @ peaceful solution to this problem because it gives
articipate in it directly. Instead, they choose their - eihial opportunity to all individuals before the law
representﬂtives through an election process. These of la;d It shows a way to deal with differences and
’ , - - conflicts.

: Moreover, in a democracy, decisions are taken
- by the majority party or parties. The other parties
. together form the opposition. But, it does not mean
. that only the will of the majority will be taken into
. consideration. A democratic government tries to
. accommodate minority opinion also in order to
. enjoy the support of the people.

Enhancing Human Dignity

Legislative Assembly

g . Q Democracy enhances human dignity because it
representatives take decisions on behalf of the ;o . e by the people themselves. The basic idea

entire population. While makir.lg decisio_ns, they of a democracy is that people rule themselves by
ke S, e et aiitbes T i | PR kR ot of e e T
power Ef tge 'government and increase peop es ’ gemocraCyA:ims to achieve social, political
par.tigipation in Fhe decision-making m;;g:gli::]l; and economi'c'equality. .It'g_i\_;es equal stalus
Sesariins ot i e Riment, ey g | 14 EpOies f o o iecas s predie
forit at the time of re-election and make it lose. government makes special provisions for the

: '\ socially or economically weaker sections. A large
Accommodation of Differences S

: fare schemes have been
= ; soihen B8 ople | pumbcr of such Tvel are At
Differences or conflicts may arise . implemented to bridge the gap betw

of different regions, religions, langhages CSStSi; - and the poor. This overall enhances human dignity.
CUtures, genders and economic backgrounds €o

TB g

Welfare Programmes

Police—managing Conflicts  DEMOCRACY



Universal Adult Franchise >

the power to vote. This is an essential fegture of
a democracy. No government can claim itself to
be a democratic government without allowing all
eligible adults to vote.

In the earliest democracies of the world,

only men who had a certain amount of§
property and education were allowed to vote !

by the governments. The women, the poor and i
: Political Parties

uneducated persons were not allowed to vote.

In India, the
voting age is 18 years.
All citizens of India
who have attained
the age of 18 years
or above, can vote
whether they are
men or women, rich
or poor, educated or
uneducated.

People in queue to vole

Elections

Regular. elections are an essential feature of
a democracy: The Election Commission of India
is an autonomous constitutional authority which
conducts elections in India. Elections are held at :
periodic intervals. In India, elections are held after

every 5 years. For elections, the state is divided into : MOr€ than half of the seats in the legislature,

small divisions known as electoral constituencies. | €21 form a government. The party that forms e
People elect one leader or representative from :
each constituency. The official list that contains

AP the names of all the |

uERBEA ohure B : Coalition Governments

people in a district
who are entitled to
vote, is known as the
electoral roll or the
voter’s list. Through
voting in elections,
people elect leaders

A woman casting her vote

to represent them. 0
These representatives 8°Vernment. However, the B.J.P. has got 2%

form the government. \ majority in the Lok Sabha.

‘

: They take decisions on behalf of the e
h try h population. If the government wants , Con-tk*
It means that all adults in the country have :

to be in power, then its members hay, tonuE
re-elected by the people. Again at the be.

' re-election, people can feel their poye, :Gr
: democracy. If the people are not satisfied Wity 3
; working of the government, they may not yy

e fn
it and make it lose. Thus, regular electiong restg:

the power of the government and increase Pecpie'
participation in a democracy. §

A political party is an organisation of People

: who have similar views or a set of beliefs o,
- political issues. They aim to contest and
elections and
- capture political
:  power so that
. they can form a
government. To
. win the elections,
: political parties
: need to win the

support of the
people. There are
many political
parties in India.

If any party wins

Symbols of Various
Political Parties

government is called the ruling party. While ‘the
other parties are known as the opposition parties

" no single party wins a clear majority, “,VO.Of
more parties may join together to obtain majon?l
That is, their collective strength in the ass¢™ ;
would provide the required majority to forﬂ("j 3
government. This type of government is s :]
coalition government. This is a post-poll ammﬁ:‘
The present NDA government at the cen™® v

Prime Minister Narendra Modi is 2 c% ’l’uw

SOCIAL SCIENCE - ETIIF NI : 7
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== ~ IMPORTAN

B Wi, of T POINTS
e Democracy 1s a form o government ; sl
people elect their own representative: - Byt . * Conflicts may arise when people of different
: : e - - ; I 3 e e
o Most countries in the worlg today have 5 | gﬁngs ;elildglons, languages, castes, cultures,
democratic form of government.

€conomic backgrounds do not

er. Democr, i
o In 2 monarchy, the head of the y acy provides a peaceful

: oyal family is th solution to this problem because it gives equal
head of the nation. V.55 the ;)};%ortunities to all individuals beforeg;he la\‘aqr of
: ; i and.
elna d1ctat0r§hlp, people have no rights and all the : D e
powers rest in the hands of one man. ° ; Crrllozrac}): enhan]ceshhuman dignity because it is
. st o Tule by the people themsclves.
h -
. Eeum ajanapad of vaishali was the world’s first . ® Universal Adult Franchise means that all adults in
I" o ' a country are allowed to vote.
e Britain is regarded as the first modern democracy, | Regular elections are an essential feature of a
o Equality and justice are the central theme of a democracy.
democracy. * A political party is an organisation of people who
e People participate in the decision-making process have similar views or set of beliefs on g
in a democracy through clections, They choose lssues: ) .
their representatives who take decisions on behalf o If no single party wins a clear majority, two or more
of the entire population.

parties together form the government. This type of
government is called a coalition government.

)

¥ é EXERCIS
L Multiple Choice Questions (MCQs)
Choose the correct option from the following :
i ?
1. Which one of the following systems refer to a rule by the common people
(@) Mona:cl{y (b) Dictatorship " (¢) Democracy (d) None of these
2. In a monarchy, the head of the natic‘m is the
a) leader of people’s representatives §
Eb% single rulzr who gains power generally through a military take over
(¢) head of the royal family
(d) none of these

3. The Mahajanapad of Vaishali was the world's

Es |

et

(a) first republic (b) third republic (©) first monarchy (d) first dictatorship
1 llowing factors is the central theme of a democracy ? ~40TSE
B ?/)hgguogt;f e o (b) Discrimination (c) Non-violence (d) None of these
a . . . . l
5. Which of the following institutions isiare the features of denwcra.tlc institutions ? wors @
' (a) Universal Adult Franchise (b) Elections
(¢) Political parties (d) All of these
6. Universal Adult Franchise means, that all adults in the country are
. (a) allowed to do business *(b) allowed to vote .
(©) allowed to make political parties (d) allowed to contest elections

- 3 —— DEMOCRACY




11 Very Short Answer Type Questions — ————
1. Define democracy.
2. What do you mean by monarchy ?
3. What is dictatorship ?
4. Mention any two key elements of a democracy. <058
5. What do you understand by Universal Adult Franchise ?

111. Short Answer Type Questions —— ———
1. ‘Democracy means rule by the Common people’. Justify this statement. o188

. What are the main features of a monarchy ?

. Write a brief note on Universal Adult Franchise.

. Why do you think that equality is the central theme of a democracy ? -+iGis

. What do you know about a coalition government ? -

g1 o= @ N

1V. Long Answer Type Questions
1. What are the key elements of a democracy ?
2. What is the role of election in a democracy ? Explain. <458
3. Discuss the role of political parties as a democratic institution.

V. Match Column-A with Column-B

Column A Column B

(@) Equality
(b) Feature of Democracy .

1. Monarchy

2. Democracy

3. Regular Elections

4. Origin of Democracy
5. Political Party

() People with similar views on political issues
(d) Royal Family .
(e) Ancient Greece O -

r’-—__

({IMORE|TO EXPLORE!

Picture Study

Look at these pictures and answer the following questions.
(1) Identify these persons.

(if) From which countries do they belong ?
(iii) Mention some features of their governments,

Web Link

For more information log on to the following link :
o http:dlenwikipedia.orglwikilDemocracy-in-Indiq

SOCIAL Y1 (% -0 POLITICAL:SCIENCE By
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Given below is the link for tutorial.

. To access the video, tap the following link:

https://voutu.be/Vf2mnEGtpDc

Open the given link in You Tube and thoroughly go through it.

CIVICS ASSINGMENT

Do the given assignment in your S.ST notebook.

1.Define the following terms: -
(i) Democracy

(ii) Monarchy

(iii) Dictatorship

(iv) Coalition Government

(v) Universal Adult Franchise

2.Match the following:

Monarchy Saddam Hussain
Dictatorship India
Democracy Saudi Arabia

3.Give very short answers: -

(i) Name the authority that conducts ‘elections’ in India.
(ii) After how many years elections are held in India.

(iii) Name the world’s first republic.

(iv) What is the voting age in India.


https://youtu.be/Vf2mnEGtpDc

4.Draw the symbol of five political parties of India.

5.What do you understand by the term all persons are equal before law? Why
do you think it is important in democracy.

6. Suppose you are contesting elections from an ‘assembly constituency’.
Prepare a short speech which you intend to give to the voters.
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